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Colligo Contributor Viewer

Introduction

Colligo Contributor Viewer lets you easily download content from SharePoint sites to your local machine
for instant read-only offline access.

Please send questions and feedback to support@colligo.com.

Benefits

e Stay up-to-date with offline synchronization
e Find what you need, quickly and easily
e Access document libraries and lists offline

Features

e Synchronize specific folders, libraries, or entire SharePoint sites

e Choose automatic or manual synchronization

e Find content using Windows Desktop Search

e Display content in the same views you’re used to on the desktop.

e Easily change offline views to also display by user and date. Multi-value lookups and metadata are
supported.

e Enhance use with SharePoint views offline

o Take document libraries offline

e Get read-access to documents and forms

e View both custom and standard lists

e Access events, issues, links, contacts, announcements, tasks, and agendas

Platforms Supported

e Microsoft SharePoint Server 2010, MOSS 2007, or SharePoint Portal Server (SPS) 2003
e SharePoint Foundation Microsoft Windows SharePoint Services (WSS) 3.0, or 2.0

e SharePoint 2010 Online (Office365)

e SharePoint 2013 Preview

e QOutlook 2007, 2010, 2013 Preview (32-bit and 64-bit)

e Windows XP Professional, Windows Vista, Windows 7, Windows 8
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Installing and Activating Contributor Viewer

To install and activate Contributor Viewer:
Double-click either Setup.exe or .msi.
Follow the steps in the install wizard.

1.
2.
3.

After the install is complete, the following dialog displays:

Activate Colligo Contributor &J

Welcome to Colligo Contributor!

To start using this software, please activate it while connected to the
Internet. Providing your email address will ensure you periodically
receive product notices, version releases, and our newsletter, Your
personal privacy is important to us - your infarmation will never be
shared with a third party.

Click here to view our Privacy Statement,

RegistrationInformation

Mame: |

Organization: |

Email: |

Activate | Exit

Colligo Contributor Viewer

Enter your information and click Activate. If you do not activate Contributor Viewer, it will not

launch.

After you have installed Contributor Viewer, choose Colligo Contributor from your Start menu or

from the system tray icon to launch the interface:

(@ Colligo Contributor Viewer = ] S
Elle gSite View Help
Siter [1, <No Sites> hd esynchronize‘.. hd 0{ View Sync Issues
Filter ~
Sync Issues %
Issue Item Site List
. | i
'@ Mo Synchronization Activity

The Document Libraries and Lists display in the left column, and the content of the selected list or

library displays in the right section.
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Colligo Contributor Viewer

Activating Contributor Viewer Manually
If you are unable to connect to the activation server, the following error message displays:

-
Activate Collige Contributor l&,l

Activation Failed

The Colligo Activation Server was not reachable, Activation
will be attempted the next time you use the software.
Alternately, you can choose to activate through email,

Activate via Emai | Activate Later |

Click Activate via Email to create an activation request file. The following dialog displays:

Activate Collige Contributor Li_E-J

To activate Colligo Contributor File Manager via email, dick
"Export Activation Request™, An activation request file will be
generated, which you can then email to Colligo Technical Support
where your activation request will be fulfiled.

Email Colligo Support: support@colligo.com

| Export Activation Request | Exit |

L S

Click Export Activation Request. This creates a .txt file that you can save anywhere on your machine,
and then attach to an email that you can send to Colligo to request a manual activation.

Checking for Updates

To check if you are using the most current version of the program:

1. From the Help menu, select Check for Update. The www.colligo.com site launches.

2. |If there is a newer version available, click the Download the latest version now link to install the
newer build.

Upgrading to Contributor

If you want to be able to create, edit, or remove content, you can upgrade to Colligo Contributor. To

access upgrade options, from the Help menu, select Upgrade to Contributor. The www.colligo.com site
launches.
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Connecting SharePoint Sites

You can connect your SharePoint sites to Contributor Viewer in one of two ways:
e Using the Connect to Contributor option in Internet Explorer
e Using the Download New Site option

Using the Connect to Contributor Button

1. Navigate to a SharePoint List or Library in Internet Explorer.
2. Click the Connect to Contributor icon on the toolbar.

http://vs-sp2010/PM/Shared%200ocume @ ~ & X

Shared Docurnents - All Do... |
File Edit Wiew Favorites Tools Help

i v B v =] == v Pagev Safety~v Tools~ g~ N N @ (~ 3 @

Connect to Contributor

Library Tools

Site Actions ~ [ I Documents Library

3. The Download New Site dialog displays.
( + Download New Site @1

Site: | <Mew Site> Bd

URL: 10 =P

Examples: http://serverworkspace
https: /fsecureserver fworkspace

Server Authentication
(¥ Use default credentials
(™ Use the following credentials:

User name: |

Password: |

Download | Close |

e o

4. Select either your default Windows credentials, or supply other user-specific credentials.
5. Click Download.
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The Select for Synchronization dialog displays the lists and libraries you have permissions for:

[=—3=]]

p
Select for Synchronization

—Document Libraries and Lists
" Synchronize all document libraries and lists
& Synchronize the following:

E Announcements

[ calendar

[=] Links

3| Private Documents

[Tl Product Lifecycle Dashboard
[1] release Dashboard

i3] Shared Documents

23| Site Assets

3] Site Pages

[ [E]Tasks

[ I R e |

Click the chedkbox to enable or disable synchronization for
the spedfied list.

Checkal |  Unchedcal | Fiter... |

Synchronize I

Close |

“ o

Check the boxes beside the lists and libraries you want to synchronize
All buttons if needed.

Click Filter to select which folders and views you want to synchronize.
The Select Filters for Synchronization dialog displays:

; use the Check All or Uncheck

. B
Select Filters for Synchronization u
£~ Disable Synchronization for this Document Library
' Synchronize Entire Document Library
& Only synchronize content based on the following filters:
—Synchronized Folders
Available Folders Selected Folders
By
[C3 Arakelyan et al v. Contoso LLC
| [Z ICE Co vs Contoso
&dd == |
Remaove |
—Synchronized Views
Selected Views I
[T All Documents
[T My Matters Add == |
j Recent Documents
Remaove |
| |
Cancel Filker Refresh CK Cancel
. |
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Colligo Contributor Viewer

8. Choose from the following options:

e Disable Synchronization for this Document Library: choose this option if you do not want
the document library to be available offline.

e Synchronize Entire Document Library: choose this option if want to synchronize everything
in the specified document library.

e Only synchronize content based on the following filters: choose this option if you want to
selectively choose what folders are synchronized. In the Synchronized Folders section,
select a folder you want to synchronize and click Add to move it to the Selected Folders

column.
9. Click OK.
10. Click Synchronize to download the information for the lists and libraries you have selected.
Synchronization In Progress =
SIS Site: i B's Beverages
[ & gfiesseverages | server  g3http:/jsupport.coligo.com/bsbev

Synchronization Activity
Current List: 5] Site Design
Status: Completed successfully.

Received: 14of 14 Sent: 0of 0
Working ...
- = e
Cancel
c Issues
[¥] Close this window¥yhen synchronization completes
- Jient Docs Folder
L\ Project Tracker
Documents + || Use this library to store forms, reports and emails relating to issues
New v | Upload v | Filter View: All Issues «| [
Name Issue Status

[ Finandial Statements
=) LE1600_Spec_us.pdf com...

* Project Tracker 5
8] sharepoint v2 revie... Test...

L Client Docs Folder

Pictures

m

Lists

= Open Projects

@ Last Synchronization: 25/02/2008 7:58:49 PM

After your synchronization is complete, you can view your offline content.
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Using the Download New Site Option

To connect a site from within Colligo Contributor Viewer:
1. From the Site menu, choose Download New Site:

(13} Colligo Contributor Vies

Site | View Help

. z Synchronize. ..

e... v Qﬂ View Sync Issues

Colligo Contributor Viewer

Download New Site...

i
i
@

Manage Sites. ..

| »

The Download New Site dialog displays:

-

s Download New Site

===

URL:

Examples: htip://serverworkspace
https://secureserver /workspace

Server Authentication
(@ Use default credentials

) Use the following credentials:

User name:

Password:

Download Cancel

-

-

@ Mo Synchronization Activity

2. Enter the URL of the site and enter your default credentials, or user-specific credentials.
3. See steps 5 to 10 of Using the Connect to Contributor Button.
After your synchronization is complete, can view your offline content

Editing Lists and Libraries

After you have added your site and chosen which lists and libraries you want to sync, you may want to
go back at a later time and edit your choices. You can do this in one of two ways:
1. Right-click a list or library and select Enable Synchronization from the contextual menu:

12/10/2012
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Colligo Contributor Viewer

@ Colligo Contributor \I'Temr- - lilm

File Site  View Help

Site: |y Coligo Portal - :Smdﬂromze‘.. - 5_5 View Sync [ssues

View: -,

= Shared Docum: E Disable Synchronization

Enable Synchronization

Eilter Synchronization...

@, Copy SharePoint URL

Sync Issues

Issue Item Site List

1 | »

@ Last Synchronization: 8/13/2012 10:33:11AM 4

2. Synchronize the site.
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OR

1. From the Site menu, choose Download New Site.
The Download New Site dialog displays:

5 Download New Site ﬂ

Site:

<New Site> |

URL: Colligo Intranet

Product Management
Exampres:— Ty Server [WoTRSpace

https: //secureserver jworkspace

Server Authentication
@ Use default credentials
" Use the following credentials:

User name: |

Password: I

Download I Close |

2. From the Site drop-down list, choose which site you want to configure.
The Synchronize Site dialog displays:

e Synchronize Site ﬁ
=1 | Colligo Intranet b

URL: Ihtu:l:ﬂvs—spzoln

Examples: http:/fserver fworkspace
https: /secureserver jworkspace

Synchronization Settings

@ Only some lists will synchronize.
3 complete, 0 partial, 9 disabled

Configure. .. |

™ perform full synchronization

Selecting thiz option synchronizes all site content, induding users, views
and templates. If your permissions on the site have changed, you
should select this option to get all the content you now have access to.
Selecting this option will result in longer download times.

Synchronize I Close |

Click Configure.

In the Configure Synchronization dialog, choose which Lists and Libraries you want to sync.
Click OK.

Synchronize the new site.

ou kW
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Synchronizing Sites

To synchronize your sites after you have added them:

1.

Click the Synchronize menu to display the options:

(@ Colligo Contributor Viewer

Colligo Contributor Viewer

File Site  View Help

site: [5} Colligo Portal

Documents

® Shared Documents

Lists

;‘_’,anmmnize... - H}j\__‘a’\ew Sync [ssues
z Synchronize "Colligo Portal” Site...
-_.5'] Synchronize Multiple Sites. ..

i

Synchronize All F9

Download Mew Site. ..

Sync Issues

Issue Site

List

'@ Last Synchronization: 8/13/2012 10:33:11 AM

2l

2. Choose from the following:

want to synchronize

Synchronize All: select this option to synchronize all sites

changed content

Synchronize Site: select this option to synchronize the site currently displayed
Synchronize Multiple Sites: select this option to display all sites and choose which ones you

Synchronize Pending Changes: select this option to synchronize any lists or libraries containing

The Synchronization In Progress dialog displays for any of the above options:

Synchronization In Progress...

=

Site List:

Site:  Colligo Intranet

& |4 Colligo Intranet
5 Contoso LLC
3 Matter Repository

4 Product Management

Server: ':@ http:/fve-sp2010
Synchronization Activity

Current List: 3] Customized Reports

Status: Collecting remote updates ...

Received: 0of0 Sent: 0of 0

Working ...

Skip Site | Cancel All

[ Close this window when synchronization completes

Completing a Full Synchronization

Several of the synchronization dialogs have a Perform Full Synchronization option. This option means
that additional information is downloaded, including definitions for Sites, Lists, Views, and Content
Types, plus other site content that may not be retrieved during other standard sync processes.

Viewing Content

To view an item’s content, double-click it or right-click and select Open from the contextual menu.
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Setting Synchronization Options

You can specify your synchronization settings so you can ensure your content is up to date.
1. From the View menu, select Options.
2. The Colligo Contributor Options screen displays:

Colligo Contributor Options @

Storage

Storage location
|C: Wsers\tmackinnon\AppDatalLocal\Colligol:  Browse...

Synchronization

¥ Synchronize on startup

I+ synchronize when list is viewed

[ Enable background synchronization
30

Iv Automatically download lists to resolve Site Column values

Cancel

A

3. Choose from the following options:
a) Synchronize on startup: choose this option if you want your lists and libraries to synchronize
every time Contributor Client starts
b) Synchronize when list is viewed: choose this option if you want your lists and libraries to
synchronize every time you view a list or library
c) Enable background synchronization: choose this option if you want to set the
synchronization to happen in the background on a time-specific basis, and enter your
preferred time interval
d) Automatically download lists to resolve Site Column values: if you have lists that reference
other lists (look-ups), checking this option ensures the related referenced lists are also
downloaded
4. Click OK.
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Viewing Content

To view an item’s content:

1. Double-click the item or right-click it and select Open from the contextual menu:
Colligo Contributor Viey

File Site Wiew Help
Site: |1, Colligo Portal - | =S[nd'1ronize... - | @_ﬁ View Sync [ssues
= Colligo Portal > Shared Documents
[ j Shared Documents
Documents Share a document with the team by adding it to this document library.
= Customized Reports Filter +

view: All Documents - | [

= Farm Templates Mame Modified

3 Briefings 2/2/2012 :02 AM 1=
[CJ copytest 6/7/2011 4:44 PM
[C1 SPC 2011 Presentations 9/30/2011 12:18 PM

® Shared Documents

|=| abstract.jpg 8/23/2012 3:39 PM
@] acme quote 2003.docx 8/15/2012 3:27 PM

- 8/23/2012 3:31PM
R arma.p 5/30/2012 3:19 PM
| books. @ Open with Microsoft Ward 8/20/2012 2:40 PM
= brande @, Copy SharePoint URL 4/18/2012 12:00 PM
&) Briefea 8/15/2012 3:20 PM
@ Brigfca| = 0Py SharePoint Doc 1D URL /14/2012 9:55 AM
11 Colligo Marketing_23May12 12.48,03_BYOD Survey Results W... 5/30/2012 11:14 AM

J |

|Svnc Issues
I

| () Last Synchronization: 8/30/2012 1:33:10 PM y

2. The item displays in the native program.
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